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1. Installation und Registration 

1.1 Activation 

Activation Windows 

Upon starting NEAT projects 2 professional for the first time, you 

will be prompted to activate the program. Proceed as follows: 

Install NEAT projects 2 professional as described in the installation 

instructions.    

Enter your serial number. For the box version, this can be found on 

the accompanying booklet. If you have chosen to download the 

program, you will have received the serial number by email directly 

following your purchase. 

 

Finally, click on the “Activate” button. The software has now been 

successfully activated! 

 

Activation Mac 

Upon starting NEAT projects 2 professional for the first time, you 

will be prompted to activate the program. Proceed as follows: 

Install NEAT projects 2 professional as described by the installation 

instructions.    
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Input your serial number. For the box version, this can be found on 

the accompanying booklet. If you have chosen to download the pro-

gram, you will have received the serial number by email directly 

following your purchase. 

 

 

Finally, click on the “Activate” button. The software has now been 

successfully activated! 

Note: NEAT projects 2 professional can be installed on up to two 

computers using the same serial number.   

A second serial number is not necessary. When installing the pro-

gram on a second device, simply enter the serial number again and 

press “Activate”.   
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1.2 Installing Adobe Lightroom Plug-ins 

Adobe Lightroom Windows 

It can often occur that Lightroom will not automatically install. 

If so, continue as follows:  

Copy the plug-in file “Lightroom Plug-in” from your CD/Download. 

You also can download the plug-in directly from our website 

https://www.franzis.de/projects-software. 

Paste the folder to a desired location on your PC. We recommend 

the same folder where the presets are saved: 

C:\User\Username\NEAT 

Projects 2 Pro 

Start Lightroom and navigate 

to „File  Plug-in Manager“.   

 

Click on “Add” in the plug-in 

manager.  

 

 

https://www.franzis.de/projects-software
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Select the corresponding Lightroom Plug-in (which you just copied to 

your PC) from NEAT projects 2 professional by going to “Select 

Folder” and then “Done”. 

Click on „Select Folder“ followed by „Done“.  

 

In Lightroom, the plug-in can be found under “File”/ “Export with 

guideline”  “Export to NEAT projects 2 professional“. 

OR: 

In Lightroom, right click directly on the image and select “Export”  

“Export to NEAT projects 2 professional“. 
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 Adobe Lightroom Mac 

The Adobe Lightroom plug-in will not be automatically installed on a 

Mac. Continue as follows: 

Install NEAT projects 2 professional and save it in the programs 

folder on your Mac.  

Copy the Plug-in-ZIP from the “Lightroom Plug-in” folder on the 

CD/Download.  
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The file was saved as a ZIP for security purposes. Unpack the file by 

double-clicking and paste the plug-in into the folder of your choice. 

We recommend: 

“User/Username/NEAT Projects 2 Pro“. 

 

Start Lightroom and go to “File”  “Plug-in Manager”  “Add”.  
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Select the Lightroom plug-in (which you just copied to your Mac) 

from NEAT projects 2 professional. If the plug-in is not immediately 

marked with a green check, close and restart Lightroom. The plug-in 

should not be in use. 

There are multiple ways to transfer an image from Lightroom to 

NEAT projects 2 professional.  

“File”  “Export with guideline”  “Export to NEAT projects 2 pro-

fessional“. 

OR: 

In Lightroom, right click directly on the image and select “Export”  

“Export to NEAT projects 2 professional“. 
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Side-Note: Why isn’t there a Photoshop Plug in? 

NEAT projects 2 professional does not contain a Photoshop plug-in 

since the upload of image sequences (multiple images) is not sup-

ported in Photoshop. A total of at least three images is required in 

order for the program to accurately detect movements. The program 

only includes plug-ins for Adobe Lightroom which does allow for the 

upload of image sequences.  
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2. What´s new? 

NEAT projects 2 professional offers a variety of new features. Here 

is an overview of some of the most important developments: 

- 5 new Motion Fusion Profiles: remove motion (soft), re-

move motion (very soft), add motion (dark), add motion 

(light), add motion (colour). For additional information on 

motion fusion profiles, please see chapter 10. Motion Algo-

rithms. 

- Fusions-Profiles: Create, save and load your own Motion 

Fusion Profiles. 

- Upload up to 200 images 

- Presets and Additional Functions: 18 new presets have 

been added in four different categories along with the Fa-

vorite System, Preset Combiner and the Gallery Function. 

- Variation Browser: For Presets, the Optimisation Assistant, 

Fusion Algorithms and Fusion-Profiles. 

- Exposure-Prediction: New exposure correction processes 

for image sequences. This allows for the (limited) upload of 

bracketed series in the form of motion sequences. The op-

timization of the lights works out as many details as possi-

ble from the light areas of the original images. 

 

- Significant Optimisation: The Fusion Algorithm calculation 

has been accelerated by up to 40%. Automatic image rota-

tion has been sped up by up to 50% and RAW image up-

loads by 30%. 
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- Selective Drawing: 4 Composing Levels and 48 Processing 

Methods (see chapter 11. Local Adjustments/ Selective 

Drawing) 

- 1:1 Comparison Window 

- Granulation Module: Natural Grain in 6 Forms and Fractal 

Grain. 

- Intelligent Colour Space (SCA method) 

- RAW Module Expansions: Graphic configuration of horizon 

correction, Category FX, create your own profile, adjustable 

display options along with the following effects: 

 Normalise Lights/Shadows  Colour Denoising 

 Exposure  Colour Gradient 

 RGB-Exposure  

 

- Print Final Image  

- Clipboard 

- Colour normalisation of input images 

- Scaling function for input images: From 10 to 400%. The 

scaling calculation of new images is made based on the size 

of your screen. Small scaling adjustments can be useful 

when uploading your image to a webpage directly after edit-

ing.  

- Interactive Contrast Optimisation in the Motion Fusion 

- Note Function in the Undo-Timeline  

- Create Exposure Bracketing: New mode „according to EV 

value“ 
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New RAW-Formats: 

- Apple iPhone 8 (*), iPhone 8 plus, iPhone X 

- BlackMagic URSA Mini 4k, URSA Mini 4.6k, URSA Mini Pro 

4.6k 

- Canon CHDK hack PowerShot A410, A540, D10, ELPH 130 IS, 

ELPH 160 IS, SD750, SX100 IS, SX130 IS, SX160 IS, SX510 HS, 

SX10 IS, IXUS 900Ti 

- Canon PowerShot G1 X Mark III, G9 X Mark II, EOS 6D Mark 

II, EOS 77D, EOS 200D, EOS 800D, EOS M6, EOS M100 

- Casio EX-ZR4100/5100 

- DJI Phantom4Pro/Pro+, Zenmuse X5, Zenmuse X5R 

- FujiFilm S6500fd, GFX 50S, X100, X-A3, X-A5, X-A10, X-A20, X-

E3, X-H1, X-T20 

- GITUP GIT2P 

- Hasselblad H6D-100c, A6D-100c 

- Huawei P9 (EVA-L09/ AL00), Honor6a, Honor9, Mate10 (BLA-

L29) 

- Leica CL, M10, TL2 

- LG V20 (F800K), VS995 

- Nikon D850, D5600, D7500, Coolpix B700 

- Olympus E-PL9, E-M10 Mark III, TG-5 

- OnePlus One, A3303, A500 

- Panasonic DMC-FZ45, DMC-FZ72, DC-FZ80/82, DC-G9 (std. 

res mode only), DC-GF10/GF90, DC-GH5, DC-

GX800/850/GF9, DMC-LX1, DC-ZS70 (DC-TZ90/91/92, DC-

T93), DC-TZ100/101/ZS100, DC-TZ200/ZS200 

- PARROT Bebop 2, Bebop Drone 
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- Pentax KP 

- PhaseOne IQ3 100MP Trichromatic 

- Samsung Galaxy Nexus, Galaxy S3, S6 (SM-G920F), S7 Edge, 

S8 (SM-G950U) 

- Sony A7R III, A9, DSC-RX0, DSC-RX10IV 

- Yi M1 

- YUNEEC CGO3, CGO3P 

- Xiaoyi YIAC3 (Yi 4k) 
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3. Configuring the User Interface 

Adjustable Font Size for Menus and Headings  

Provided in the program’s main menu under View -> Font Size, this 

option lets you customize the font size of menu texts as well as in-

program headings.  

 

Font size settings can be adjusted directly at program runtime.  

Users working on 4K monitors have the possibility to improve menu 

legibility by increasing the font size. 
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4. Photos Done Quickly  

Four clicks in NEAT projects 2 professional and you’re done: 

1. Load Stacking Sequence 

 

Simply drag and drop your image sequences onto the start screen. 
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2. Post-Processing   Preset Selection 
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3. Optimisation Assistant   
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4. Crop image, save and you are done! 

 

Just like that and you’re finished editing in no time – or go the crea-

tive route with individual image adjustments, the RAW Module or 

selective painting: 

NEAT projects 2 professional offers the necessary tools for both.  

 

Located at the top of your screen is the main menu along with the 

toolbar. The toolbar contains the following functions (from left to 

right): 

 

o Image Sequence Browser     

 

o History Viewer      

    

o Import Image Sequence     

      

o Open Projects     

 

o  Batch Processing    

 

o Load Sample 1     

 

o Load Sample 2      

  

 

Optionally image data can also simply be „dropped“ onto the screen 

by Drag & Drop. Then the image data is uploaded automatically. 
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5. Importing Image Material 

You can also choose to upload images using the file menu. When 

attempting to upload only one or two images, a notification will ap-

pear stating that an image sequence must include three images or 

more in order for the program to successfully complete motion de-

tection. 

 

 

 Image Sequence Browser   

For a better overview of your image sequences, you can use the 

image sequence browser before uploading your image sequences. 

Click on the corresponding symbol in the task bar. A preview window 

will open. Select your image folder as the „Source Folder”. 

NEAT projects 2 professional will now display a preview image. 

Hover you mouse over the preview image to enlarge it.  

The file type-filter is quite useful here. JPG series are often stored 

together in the same folder alongside RAW image. Enter RAW in the 

File Type field and only RAW images are displayed without dupli-

cates. 

The image search is complete once the progress bar has reached 

100%. 
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From this point on you will be able to upload the desired image se-

quence. Select the desired series with a right mouse click and choose 

the “Open as Project” option from within the context menu. Alterna-

tively, double-clicking the image in Preview will also open the image.  
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NEAT projects 2 professional uploads the images from your chosen 

sequence the same way as the simple Drag & Drop method.  Now 

we can begin with Post-Processing. 
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6. Menu Bar 

6.1 File 

 

File → Start  

When you are finished editing 

an image or would like to 

close your current image, 

clicking on Start (or Ctrl + N) 

will close the image currently 

open. 

 

File → Import Im-

age Sequence…  

In order to open an image, 

click on Import image se-

quence (or Ctrl + Shift + O) … to search for the sequence you would like to 

edit. 

 

 File → Image Sequence Browser…  

Select your sequence folder from within the “Source-Folder”. NEAT projects 2 

professional immediately begins its calculation process and automatically 

gathers the best photos from your sequence. From here you can then upload 

your preferred image sequence. 

 

 File → History Viewer …  

Clicking here will provide you with an overview of your separate projects and 

allow you to choose between them. 
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File → Save Final Image …  

If you are content with your editing results and would like to save your image, 

click on Save Final Image (or Ctrl + S) … 

 

File →Open Final Image in External Program… 

If you would like to continue editing your current image in another program, 

you don’t even need to leave NEAT projects 2 professional. For this, simply 

click on Open Final Image in External Program. 

 

File → Create Exposure Bracketing … 

Click here to create an exposure bracketing from your image. You can choose 

between three, five, seven, nine or eleven exposures. 

 

File → Print Final Image…  

Click here to print your final image. The image is automatically and correctly 

scaled to the print medium. 

 

 File → Copy Final Image into Clipboard… 

The final image is posted to the clipboard. You can then seamlessly insert it 

into other programs. 

 

File → Projects 

If you’ve already begun a project in NEAT projects 2 professional and would 

like to continue editing, open the file by clicking on Projects. 

 

 File →  Exit 

Click on Exit (or Ctrl + F4) to close NEAT projects 2 professional. 
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6.2 Edit 

 

Edit →  RAW Processing  

Whenever you want to easily edit a photo, 

simply click on RAW processing to do 

things like alter colours in the photo or 

distort the image (please see 15. RAW 

Image Editing). 

 

 

 Edit → Edit Image Sequence 

NEAT projects 2 professional utilizes a complex process to filter out all 

accurately exposed pixels and combine them into one image. 

 

Edit → Edit Weightings 

The Weight Painter is a tool used for manually editing individual images in a 

series (see 13. Edit Weighting) 

 

Edit → Post-Processing  

Once you have edited or removed noise from an image, you find yourself in 

Post-Processing Mode.    
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6.3 View 

 

 

View → EXIF Information Window 

This window displays (if available) all image file EXIF information such as 

location, camera type, exposure duration and capture time. 

 

 View → Histogram  

The histogram provides you with a consolidated overview of the Light Distri-

bution Information present within your photo. This makes it easy to recog-

nize if your photo is over/ underexposed. 

 

View → Full Screen View On/Off 

If you ever feel distracted by the task bar, you can toggle between a normal 

and full screen view by clicking on Full Screen View On/Off. 
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View → Interface-Style.. (individual)  

Clicking on Interface Style... will allow you to alter the colour scheme for 

NEAT projects 2 professional. The colour scheme you have currently select-

ed will appear in brackets. 

 View → Font Size …  

Change the font size levels for menus and headlines between small, medium 

and large. 

 

 View → Frame Colour: Grey Cart → automatic 

If you click on Frame Colour: Grey Cart  automatic, the program will set 

the your image’s average colour value as the frame colour. 

 

View →  Restore Window defaults    

Returns the current window to its original size. 

 

6.4 Extras 

 

Extras → Batch Processing   

Batch processing in NEAT pro-

jects 2 professional enables the 

automatic processing of multiple 

image sequences. 

 

Extras → Preparing Image  …  

Here you can begin to prepare 

your images prior to post-

processing (see chapter 7. Image 

Preparation). 
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Extras → Benchmark  

If you would like to know how quickly your PC can remove noise from your 

images, Benchmark is the function to choose. The programs will render five 

different images in real-time and provides you with an evaluation on a five-

star scale. 

Extras → Settings… (Ctrl + P)  

Here you will find the various configuration options adaptable to your unique 

preferences offered in NEAT projects 2 professional. 

 

Program: Program Location 

Here you can determine in which folder projects, exposure bracketing/ photo 

series, final images and default settings will be saved. 
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Program: Language 

Here you can change the NEAT projects 2 professional program language to 

either German, English or French. 

 

Program: Accelerate GPU 

Here you can choose to either activate or deactivate graphic card computing 

speed acceleration. 

 

Program: Tooltips 

Hovering your cursor long enough over specific tools or menu options will 

prompt the display of a short text offering an explanation of the function or 

tool. This is called Tooltip. Tooltips can also be deactivated here if preferred. 

 

Program: Progress Bar 

While the processing of effects in NEAT projects 2 professional, the pro-

gress will be displayed with the help of a progress bar. Here you can decide 

when and whether to display the progress bar. 

 

Program: Projects 

When selecting the compression level, you are deciding how much storage 

space will be allocated for each one of your projects. In other words, you are 

deciding on how quickly the storage is performed. A lower level saves the 

projects faster, a higher level reduces the amount of storage space available 

on your hard disc. 

 

Program: Undo 

With the option “save undo steps in projects”, you can save all undo steps 

within the project file. The undo-steps will then be completely reproduced 

when the file is opened. This creates a significantly larger project file. Set the 

maximum number of undo steps (1, 5, 10, 20 or 50). If you do not wish to 

set a maximum, select “unlimited”.  
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The minimum free disk space specifies the amount of free space on your 

hard drive that will not be taken up by saving undo steps. This ensures the 

proper functioning of your operating software. By default, this is set to 10% 

of your hard disk capacity but can be increased or decreased accordingly. 

 

Program: Preview Mode 

In preview mode you can choose between the modes “optimal” and “quick”. 

With the “optimal” mode activated, the preview size is adapted to the size of 

the original image. It guarantees maximum preview quality. If the “quick” 

mode is activated, the preview size is reduced to half of that of the original 

image. This guarantees you the highest possible speed in preview mode. 

Moreover, you can set the size of your preview area in megapixels if you have 

not selected optimal or quick mode). Select a high value if you have a very 

fast computer. 

Export 

 

 

External Programs 

Here you can choose in which format NEAT projects 2 professional will 

export images to external programs. You can specify as well which programs 

should be used for external image editing. 

Navigate to the file in which the function is installed and select it. 
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Save formats 

 

 

Jpg 

Jpg or Jpeg is the most common and popular format for most cameras and 

image editing programs. Here you can control the quality as well as optimally 

compress the image. Compressed images with high quality look better but do 

require more storage space. 

Tif 

Here you can choose between different compression methods for your Tif 

files. 

Png 

Png is popular for its graphics and digital visualisation. Here you can choose 

between a number of compression methods. 

 

Automatic: Primary View 

Select whether the software should start in the post-processing or directly in 

the motion analysis after uploading image files. 
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Automatic: Motion Algorithms 

Here you can activate the resetting of the motion algorithms when opening a 

new sequence. 

 

Automatic: Post Processing 

Post-processing automatically sets the corn engine back to its original set-

tings with every newly started project. To use a fixed corn value in batch 

processing, set it in the program and then deactivate this option. 

 

Automatic: Security Questions and Additional Information 

Here you can choose whether or not to display security questions or addi-

tional information. 
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Automatic: Automatic Undo Points 

Creates an automatic Undo-Point before RAW development, sensor correc-

tion or selective drawing. This creates a definitive starting point after upload-

ing the image. 

 

Automatic: Image Preparation 

Displays the image preparation window when images are exported over a 

Plug-in. 

 

Automatic: Image Saving 

Activate the option “always save in highest resolution” and the processed 

image will automatically be saved in full resolution, even if the preview mode 

is active. Activate the option “show crop window when saving” and the crop 

window will automatically be displayed before image saving. 

 

Automatic: Batch Processing/ Image Data Browser 

Here you can activate the automatic loading with the last used directory 

when opening the image data browser. You also activate the automatic inclu-

sion of subdirectories in the image data browser and batch processing.  

You can also prevent files from being overwritten by automatically adding the 

original file extension (e.g. jpg, tif,...) for the file name created in batch pro-

cessing. 

 

Extras → Reset  

This returns the current user interface to its original size. 

 

Extras → Create Restore Point (Shift + Z)  

If you would like to save your image in its current state and continue editing 

without initiating a file-save, simply select the option Create Restore Point 

or (Shift + Z). This allows you to return to the last saved state of your image 

at any time. 
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Extras → Timeline (Ctrl + T)  

Click on the Timeline or (Ctrl + T) to display all saved Undo-Points. 

 

6.5 Add-ons 

 

Add-ons → Import Add-on  

With the help of Add-ons, you can now not 

only import Presets into NEAT projects 2 

professional but also integrate new Post 

Processing Modules that gives your Pre-

sets with an entirely new look. 

 

Add-ons → Remove Add-on  

This button lets you remove add-ons. 

 

Add-ons → Add-on Information  

Here you are provided with a display of all information regarding currently 

active Add-ons 

 

6.6 Information 

 

Information → NEAT pro-

jects – Homepage  

Click here to navigate to the 

NEAT projects 2 profession-

al homepage. 
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 Information → Show Shortcuts …  

Here you will find all keyboard shortcuts available in NEAT projects 2 pro-

fessional. 

 

Information → Supported RAW Formats …  

A list of all cameras whose RAW Files are able to be opened in NEAT projects 

2 professional. 

 

Information →  Check For Updates  …  

This checks online whether newer versions of the software are available for 

download. 

 

Information → About NEAT projects (Shift + F1)  

Information about the current version, 3rd-Party Software and Credits from 

NEAT projects 2 professional. 
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7. Image Preparation 

Here you can precisely configure the program’s settings.   

For the first steps, please use the standard settings. These default 

settings can be restored with the arrow at the bottom left. Nothing 

can be irretrievably adjusted.    
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a. Scaling: Upon uploading a bracketed series, images can be 

scaled anywhere from 25% to 400% using any one of the 6 

available scaling processes. Tip: The further towards the 

bottom the procedure is found within the list, the better the 

quality and the longer the computation time. 

 

b. Colour space conversion: advanced users can choose a 

colour space here - for all other users, it is recommended to 

not make any adjustments, to avoid incorrect colour render-

ing later NEAT projects 2 professional offers several new 

colour spaces 

(D65). The 

standard illu-

minant D65 is 

representative 

for a phase of 

natural daylight 

with the colour 

temperature of 

6500° Kelvin. 

 

c. White balance corrects colour casts that occur with shots 

taken, for example, in a warmly lit room. To start, leave this 

setting unchanged.    

 
d. With this regulator one can adjust the colour temperature 

when you’re already uploading. It is advised that you leave 

the setting on “default” and to regulate the colour tempera-

ture later in post-processing. 
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e. Optimisations: The Colour Normalisation option auto-

matically removes colour spots present in RAW image files. 

This ensures that shadows within your image remain dark 

and lights stay bright.  Automatic Brilliance Optimisation 

function can be activated for RAW file uploads in the RAW 

options section. Camera RAW formats often do not make 

use of all potential tone values. Automatic RAW Luminosity 

Optimization compensates for this by enhancing tonal val-

ues, resulting in the creation of a more comprehensive his-

togram for each RAW image. If the checkbox beside Auto-

matic Rotation of Images is filled, images are corrected 

according to the orientation present in their Exif data.  

 
 

f. Noise suppression: these buttons allow you to select the 

precision of the noise removal, and the slider regulates the 

degree of the sharpness for the edges. Here dark images 

can undergo significant noise removal and have hot pixels 

(light spots caused by the camera’s sensor in dark situa-

tions) eliminated. 

g. Exposure can be used for editing images within an expo-

sure bracket which have been incorrectly exposed and/or 

appear out of focus. Recommended for use when working 

with darker exposure brackets is the Shadow Optimisation 

Function.  This function can be applied to easily eliminate 
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colour casts and further enhance lighter areas and details in 

bright exposure brackets. 

h.  Alignment: here you can influence how the individual im-

ages of the series are congruently positioned on top of one 

another. The subtlest movement of an object, unintentional 

zooming or rotating of the camera can be considered. In the 

majority of cases, the default settings often lead to the pre-

ferred result. The automatic cropping function corrects 

empty areas at the edges of your images. 

 

Check the option „Always Display this Window“ and the Image Prep-

aration window will automatically open upon starting the program. 
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8. Post-Processing: Presets 

Directly after uploading your 

images you will find yourself in 

post-processing. Here you can 

begin editing  the results with 

filters and effects. 

Left side of the post-

processing screen:  

The presets show the breakdown 

of the live preview in categories – 

„Natural“, „Colors“, „Details“ und 

„Soft“ with the quantity of pre-

sets in the appropriate category.   

To begin, we’ve chosen the “Nat-

ural Original” preset. Clicking on 

the preview image applies the 

effect to the image in real time, 

which will then be displayed in 

the middle of the screen. 

NEAT projects 2 professional 

isn’t about image looks, but pre-

liminary presets. 43 different 

effects make your image lighter, 

darker, more vivid in colour, and 

so on.   
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Image with „Natural Bright Light“. 

 
 

 
Image after applying the „Natural Deep Shadows“ preset. 

 
 



NEAT projects 2 professional– User manual 

 

44 

All 43 NEAT projects 2 professional presets at a single glance. The 

bar “presettings” can be easily detached and adjusted to the desired 

size. 

 

 

 Preview Gallery 

 

Would you like to see all the previews for the loaded image or series? 

Open up the category “all” and then click on the symbol. 

 

Now NEAT projects 2 professional constructs a browser gallery 

with all the presets. For a larger display click on the picture. 

 

 
 

This very practical feature is reminiscent of good old contact sheets. 

You can create proofs to assess how the image with your favourite 

presets would look when printed. 
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 The Variation Browser 

 

The variation browser allows you to choose from different ver-

sions of a function and is primarily operated with the mouse: 

 

 Shifting the segment: hold down the left mouse but-

ton, before moving the mouse 

 Zooming in: Scroll up 

 Zooming out: Scroll down 

 Choosing the variant: double left click on the image 

 Setting a referent: left click on the image 

 Comparison with referent: hold down the right mouse 

button over the image 

 

The corresponding short cuts you can find under “m r-

cuts”. 

 

 
 

Click on the symbol and NEAT projects 2 professional will show 

you the entire preview gallery of that chosen category. Zoom in 

on the variant that you want to compare and set a reference im-

age. 
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This reference image you will be able to put on any image 

through a left click of the mouse. You can fade in this refer-

ence image into the other image by holding down the right 

mouse button. The border surrounding the image in a green 

dashed line shows you the reference image so that you can 

make the comparison. In this way you can compare any two var-

iants in the browser directly and visually. 

 

Example: As a reference image you choose the variant “Natural 

Original” and mark the image with a left mouse click. The green 

dashed line shows that you have chosen this image. 

 

 
 

Now you look for a different preview image. In this case preset 

„Natural Shadow“ has been chosen.  

 

 
 

Right click on the preset „Colours Intense” and the reference 

preset will fade in. As soon as you let go of the mouse button, 

you will see the „Colors Intense” again. This is how you simply 
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and purposefully compare looks with another before choosing 

the ones you like the best. 

Selection of your desired variation:  

With a double click you chose the variant. The adjustment of the 

relevant program settings will be carried out automatically. 

 

Tip: 

Your current choice will, when you open the window, be auto-

matically set as your reference image. 

 

Deleting of a variation: 

If you want to delete a variation, move the cursor over it and 

click the [Del] button. After that, click on the “compress” button. 

If you want to display the deleted variations again click on “re-

set”. 

 
 

 

 

 Combine Presets 

 

To merge two looks together use the “Combine default presets" 

button directly under the categories. These new presets will be 

saved under "Custom". It’s that easy to expand your numerous 

options and accumulate new ideas! 

 

 Import/Export of Presets  

 

Presets from earlier versions can be easily imported. Do you 

want to exchange all of your presets with a friend or just secure 

all of your treasures? Use the practical export function. 
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 Filter Presets  

Locating presets can be difficult when you have imported pre-

sets or created many additional looks. For example, enter “filter" 

into the search bar and only presets relating to “filter” will be 

shown, for example “Gradient filter” or “Colours Red filter”. This 

makes the search a lot easier. 

 

 

 Name Favourites     

Have you found certain 

presets that you love 

and instantly want to 

have handy? Click on 

the top right star in 

the preset window and 
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add the setting to your favourites. By clicking the button, pre-

views all of your favourite presets will be displayed. 

 

 

 Save Undo-Point 

With the Save Undo-Point Function you can save your edits to an 

image at different intervals and later view these in the Timeline 

and pick up where you left off. 

 

 Timeline  

In the Timeline you can view and directly access all saved Undo-

Points. 

 

 Image Sequence View 

With the image sequence view you can see all sequences of your 

image at one glance. 
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 Comparison View 
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 Activates the left/right comparison 

 Activates the above/below comparison 

 Activates the upper left/ lower right comparison 

 Activates the lower right/upper left comparison 

 Switches before and after in the compare window 

 Activates or deactivates the luminance display 

 Switch between 3 different modes for the luminance display: 

“two selective areas for shadows and light areas”, “from area 1 to 

area 2” and “outside of area 1 and 2”.  

 

Move the two luminance areas within the luminance bar from 0% 

(black) to 100% (white).  

 
 

You can also dock the comparison view onto the sidebars below 

“default settings” or “finalise”. 

 

Do you want a comparison to the original image? Simply right click 

on the middle of the image to see the before/after result. A quick 

check on the editing process is available at any time. For an exten-

sive overview with selectable areas and luminance display, click on 

the symbol bar. 

 

 Histogram  

The Histogram shows the distribu-

tion of tonal values within your im-

age. The cumulative histogram 

shows how colour and luminance 
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elements are distributed across the image. A flat cumulative his-

togram shows a brighter image; a bulge in the curve indicates a 

much darker image. You can receive a large display by clicking 

on the histogram.  

 Preview Mode  

If this option is activated your original image is displayed in a 

smaller version. If you switch it off, all calculations will be carried 

out in full-size images. Please note that deactivation takes more 

time to process in the preview mode. 

 

 Real Time Processing 

When activated, all of the changes that you have made to the 

preset settings will be immediately applied to the image and you 

will see the outcome of your adjustments directly. If this option 

is deactivated, then you will only see the outcome of your ad-

justments when you click the button “calculate afresh”:  

 

 High-Quality Display 

Activate this option to see the preview image in high-resolution. 

If the preview is set at 100%, there will be no difference. If you 

zoom in on a section of the photo however, there is a noticeable 

difference in quality.    

 

 Border Pixel Display  

The border pixel display helps to reveal areas that tend towards 

maximal light and dark values that is to white and black. Dark 

border pixels are depicted by blue and light pixels by orange. 
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Depiction of border pixels in purple and orange tones.   

If you like to brighten this image, you have to be careful of the 

orange border pixels. Light surfaces on the car and the walls 

should not become too white in order to avoid losing detail. In 

technical terms, these patches are called “burned highlights”. 

The border pixel view helps to find these critical image areas. 

 

 Motion-Map  

The Motion Map provides you with a colour display  visual rep-

resentation of all movements detected within your uploaded 

image sequence at a glance. Areas of the image containing a 

significant amount of motion will be depicted as yellow/red 

while portions with less motion will be marked blue/purple. Are-

as with less motion are displayed in green. 

Tip: Check the motion map at any point while editing to get a 

quick overall impression of the image's movement. 
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 Symbol „Original Resolution Setting“ 
 

With this pushbutton you will set the zoom factor on the original 

resolution. 

 

 „Increase the Zoom factor to the screen size“  

With this symbol you will enlarge the zoom factor to the 

maximum possible screen size. 
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9. Post-Processing: Finalisation   

Now that we have under-

stood the most important 

part of post-processing, let’s 

continue onto fine-tuning, 

which can be found on the right side of the screen under “Finalise". 

 

 The Magnifying Glass 

On the right-hand side (at the very top) in Post-processing you will 

find the 1:1 magnifying glass. The magnifying glass shows you the 

area under the mouse in a 1:1 pixel view. 

 

 

When clicking on the magnifying glass the new compare window will 

appear comparing your edited image and the original image. It sim-

ultaneously gives you the opportunity to examine the comparison 

through the magnifier display. 
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To keep the magnifying glass on a 

specific point, press down on the “L“ 

key, while you move the mouse over 

the screen. To free the fixated area 

of the magnifying glass, press down 

on the “L” key once more. 
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Click into the image area of the magnifying glass, to change between 

the display modus “divided before/after comparison” and “direct 

before/after comparison”. 

 

 Intelligent Colour Space (SCA Method) 

 

The SCA method (Smart colour space Adaption) activates the in-

telligent colour space in all calculations of the software and cre-

ates higher detail structures in the colours while increasing cal-

culation times. Select one of the methods and decide where you 

want to put your preference.  

Tip: With “Supersampling” you will get exceptional details and 

saturated colours and stark colour 

variations around contrast edges. 

 

 Optimisation Assistant 

The optimisation assistant is a very effi-

cient tool for fast, fascinating results. 

When the preset is activated, denoising, 

tonal value, clarity, dynamic and 

sharpness settings can all be adjusted by 

sliding the control to the left or right. The 

result can be seen live. 

The optimisation assistant is intelligent; it 
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remembers the values you’ve previously entered and applies the 

same settings to the next image in the same way, but adapting the 

result to the new motif. 

 If you would like to edit without the assistant, you can simply turn it 

off. If you would like to turn off the values that have been “learned” 

so far, click on the button. 

Additionally, the assistant 

can be given optimising specifica-

tions for an entire image style: 

choose between „naturally cool“, 

„naturally warm“, „soft“, „fine“ „bril-

lant“, „intense“, „muted colors“, 

„Multicolor“, „High-Key“ , „Low-Key“ 

und „Low-Key Multicolor“. 

 

 The Opacity Regulator of the Optimisation Assistant 

The opacity regulator in the 

optimisation assistant acti-

vates itself automatically as 

soon as one optimisation is 

activated. The opacity regula-

tor works on every effect that 

optimises the image as well 

as the optimising presettings. 

 

Tip: 

Set the optimisation presetting to “High-Key” and adjust the opacity 

slide control to a value between 40-60%. 

Pro Tip: Remember that the preset specifications and Optimisation 

Assistant are added together. If you select the „Natural Shadow“ 
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preset and the „naturally cool“ optimisation, you will get a darker 

image with a cooler colour mood. Not to worry, you can quickly 

change back to the “Natural” optimisation and have the familiar look 

of the preset again. On the other hand, you can compile new crea-

tive ideas and jump between intense, unsaturated and high and low 

key looks lightning fast. 

 

 Granulation module 

Natural grain 

In natural grain the different levels of photographic paper are 

simulated, which creates a natural irregularity. These following 

parameters are therefore at your disposal: 

Form 

Choose here from six different variants.  

 

 

- ISO-Number 

The preset value conforms to the average “restless value” on a 

naturally grey surface. 

 

- Size 

The maximum size of the simulated granulation. 

 

- Masking 

Gives you the opportunity to calculate the granulation in all dif-

ferent types of daylight or alternatively in light, shade or shade 

and light. 
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Complete: all brightness values receive natural film 

grain. 

 
Lights: the lights receive natural film grain. 

 
Shadow: the shadows receive natural film grain. 

 
Lights & Shadows: Both receive natural film grain. 

 

A Click on the button creates a new random distribution of 

grain and therefore a whole new look. 

 

 Fractal Grain 

Fractal grain simulates a large 

scale irregularity, which is creat-

ed through the storing and de-

terioration of photo material. 

Therefore the following parame-

ters are at your disposal: 

 

- ISO-Number 

- The preset value conforms to the average “restless value” of 

a naturally grey surface. 

- Quality 

Determines the accuracy of the calculation (number of iterations 

for the fractal algorithm) of the fractal granulation. Determines 

the accuracy of the calculation (number of iterations for the frac-

tal algorithm) of the fractal granulation 
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In the granulation module there is no singular best setting, since the 

ideal grain size, form and quality is 100% dependant on the motif. 

Here you can try out different things and find new creative paths. 

A Click on the button creates a new random distribution of 

grain and therefore a whole new look. 
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10.  Motion Algorithms 

 Choose from any of the eleven 

Motion Recognition algorithms 

and compare their effects in 

Post Processing. 

Tip: Double-clicking sets an algo-

rithm back to its standard value. 

Long-time exposure: This pro-

cess determines the average for 

every pixel in a shot to simulate a 

type of long exposure. 

 

Before using the algorithm: 
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After using the algorithm: 

 

 

Remove Motion (Multipass): The motion is determined through a 

flexible median mask based on colour channels and brightness of 

individual pixels. Since this process is well suited to most image se-

quences, it has been set as the standard. 

Before using the algorithm: 
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After using the algorithm: 

 

 

Remove Motion (Brightness): Pixel brightness is the single compo-

nent of this calculation, which makes it appropriate for black & white 

sequences. 

Before using the algorithm: 
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 After using the algorithm: 

 

 

 

 

 

 

 

 

 

Remove Motion (Colour): This technique is exclusively based on 

pixel colour and is best suited to particularly colourful sequences. 

Before using the algorithm: 
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 After using the algorithm: 

 

 

 

 

 

 

 

 

 

Remove Motion (Matrix): The matrix process uses a congruence 

matrix rather than a median mask allowing it to identify fine move-

ments and differentiating it from other algorithms. 

 Before using the algorithm: 
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 After using the algorithm: 

 

 

 

 

 

 

 

 

 

Remove Motion (Soft): The moving objects are removed by means 

of median calculation, which is most suitable for images with water 

surfaces or running water. 

 Before using the algorithm: 
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 After using the algorithm: 

 

 

 

 

 

 

 

 

 

Remove Motion (Very Soft): The moving objects are removed by 

means of a standard deviation calculation, which is most suitable for 

images with moving clouds.  
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Add Motion: The opposite of motion removal. All motion in the se-

quence will be determined and added based on pixel brightness. 

 

 

Add Motion (Dark): Accentuates every type of dark motion and 

adds them up.  

Before using the algorithm: 
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After using the algorithm: 

 

 

Add Motion (Light): Accentuates every form of light motion and 

adds them up. 

Before using the algorithm: 
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 After using the algorithm: 

 

 

 

Add Motion (Colour): Accentuates all types of colour-intensive 

movement and summates progress. 

 Before using the algorithm: 
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 After using the algorithm: 

 

 

 Motion Algorithm Browser  

Activate the motion algorithm browser and select a suitable al-

gorithm by double-clicking on an image. 
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11. Local Adjustments/ Selective Drawing 

 

 The selective drawing tool from NEAT projects 2 professional de-

serves very special attention. Firstly, this tool selectively edits chosen 

areas without complicated masks done by hand, like other photo 

editing programs. NEAT projects 2 professional includes a newly 

developed intelligent border recognition algorithm that inde-

pendently identifies borders, lines, differentiations and light differ-

ences in drawing mode. The boundaries of the area that the mouse 

has skimmed over are saved as a 

mask. These easily and precisely 

set masks serve as the basis for 10 

important image enhancements: 

„Show original image“, „Shading“, 

„Illuminating“, „Intensifying colour“, 

„Reduce Colour“, „Strengthen De-

tails“, „Reduce Details“ und „Sharp-

en“, etc. …   

These masks can even be saved as it´s own image file and used in 

other photo editing programs.    

How it all works is probably easiest to explain with an example. 

Open the selective drawing window (post-processing, finalise - bot-

tom right). Our example is a single RAW file of a rocky coast. The 

picture’s colour details are already well edited. Now we want to 

slightly darken the rocks without taking away the morning mood; the 

sky and water should not be darkened. 



NEAT projects 2 professional– User manual 

 

74 

 

 

 Quickly finalize your image with Selective Painting  

 

1. Select editing objective  

For this case, select “Shading”. Make sure that the selected mask 

function is activated and the green checkmark is showing.    

 

2. Activate drawing mode    
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3. Activate filling mode    

4. Run the mouse over the con-

tours without clicking. You 

can decide and correct the brush size afterwards. 

5. Now look at the mask display. The object where the borders 

were automatically recognised is now depicted. Click and 

hold, and then trace your mouse along the edges of your 

chosen object until it is completely selected. In the blink of an 

eye we will see the effect as well as the overlying mask. 

 

 

6. Once fully selected, blend the mask out by moving the mask 

intensity control to the left or clicking the key „M“. 
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7. You will now see only the effect that is darker rocks - our ob-

jective was “Shading”. Now you can adjust the intensity of the 

effect by sliding the control towards the + or -, according to 

your preferred strength. Done: The Rocks are darker while 

the sky and water remain untouched by the editing.  

8. Click on “Close”. You will be returned to post-processing and 

the selective change will be applied. 

 

The rocks on the right are significantly brighter after the selective cor-

rection. The sky and sea still have the same tone values as before.    

 

9. Use your quickly made mask for a further effect. Go back to 

the selective drawing. Our selective mask has remained.  
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10. Click on      and copy the mask to the clipboard. Switch 

the mask to “Sharpen” and use the  to paste the mask 

back again. Now you have only sharpened the rocks; other 

parts of the image were remain untouched. 

11. Every selectively applied effect can be activated and deac-

tivated with the green checkmarks.    

12. Borders have different intensities in every image. Presets 

normally do just fine, but sometimes it is necessary to adjust 

the contour and sharpness settings in order to reach perfect 

fine-tuned results. 

 

 

13. Have you drawn outside of the lines, despite the border 

recognition? You can easily fix it with the eraser.     If you 

only want to remove a small section, use the eraser with limi-

tation. When set to 50%, you can only remove 50% of the 

mask, regardless of how much you erase. The limited draw-

ing mode works in the same way, and only draws at a certain 

opacity. 

14. If you want to mask the entire image except for a small ob-

ject, it is a good idea to mask only the small object and then 

reverse the mask by clicking on the  

Ray filling mode  is very precise and favoured for smaller objects, 

geometric forms or subjects with straight lines, like in our example 

here. 
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With ray filling mode you can mask just the walls of the skyscraper 

while the window surfaces are not selected.    

 

Pro Tip:  You have two filling modes to choose from when you want 

to fill a mask. When do you use which mask? We used the normal fill 

mode as in our example for a large surface, which is also preferred 

for water and sky areas. 

 

Functions and Possibilities in Selective Drawing  

- Optional Mask Colours 

For the presentation of the mask as well as the brush, choose one of 

the ready-made colours.  

 

The display will be immediately adjusted to your desired colour. 
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- Selective Drawing – Creating Masks 

Masks can also be created from a colour or brightness. 

 

With the button (1) you activate the “Create Mask” modus. You will 

find yourself in the standard mode “Create Mask out of Colour”(2). If 

you want to create the mask out of a brightness, chose the (3) but-

ton. 

The tolerance controller decides, how sharp (smaller value) or soft 

(higher value) the created mask will be. 

While in the “create mask” mode, your mouse pointer will turn into a 

pipette. The colour or brightness in which your mouse pointer is set, 

will determine the type of mask being created. 

 

In the above example, we can see how a red mask has been created 

for the sky. 
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Tip: 

If you want to combine several colours in one mask, simply click on 

the desired colours after each other with the pipette on the screen. 

The current colour will with every click be added to the current mask. 

 

- Selective Drawing – Smoothing Brush 

The smoothing brush (1) gives you the opportunity to draw selective 

areas of the mask softly.  

 

To draw an area even softer, just go over the same area with the 

smoothing brush several times. 

- Global Mask Functions  

In the area of global mask functions are several special modes that 

one can use directly.  
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1.  Reducing the entire mask outline 

 becomes  

 

2.  Increasing the entire mask outline 

 becomes  

 

3.  Soft-focus effect on the entire mask 

 becomes  

 

With global functions there are two buttons – the left button fulfils 

the function with a lower effect while the one on the right with a 

bigger effect. 
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- To reset the function of a mask 

Every mask can without any influence on the other masks be reset to 

its original state. You simply click on the waste paper button (1). 

 

After clicking on the button a security query will follow, so that no 

important work can be lost by accident. 

- Adaptation of automatic masks onto the “Distortion 

correction” of the RAW module 

Selective drawing works directly with the RAW module. This includes 

the “Distortion correction” that is part of the RAW module and that is 

applied completely automatically on several drawn masks. 

 

In the example we have an example where the sky has already been 

masked. 
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When we now subsequently correct in the RAW module the horizon 

within the image, then the drawn mask will automatically adjust itself 

to the “Distortion correction”. 
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12. Composing Mode 

In the Composing mode of selective 

drawing you have the oppor-tunity 

to build up to 4 levels of images 

into your current motif. 

To switch into the composing mo-

dus, click on the “composing” but-

ton (1). 

From the list of choices (2) you can 

choose with which composing level 

you want to work with. 

With the button (3) you activate the 

currently chosen mask. Now you 

can through a click on the frame of 

the image (4) upload any image you 

wish to create the next level. 

You can use RAW images, Jpg, Tiff 

as well as several other image for-

mats. 

Underneath the display screen you 

will find the parameter area that 

begins with two buttons with the 

following functions: 

(5) Multiple Application 

Reduce the size of the image on a 

different level than the one that 

you´re currently working on. With 

this option you will be able to 

stretch the reduced image out-

wards (up, down, left, right). 
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(6) Determine the Width-to-Height Ratio 

This function allows you to determine the width-to-height ratio of 

the uploaded levels, since the width-to-height ratio in an uploaded 

image level can differentiate from the current image you´re working 

on. This preserves the proportion of the levels.  

(7) Horizontal Reflection 

This function allows the image layer to be mirrored horizontally. This 

enables more precise adjustment to the current image without hav-

ing to make changes to the image layer.  

(8) Vertical Reflection 

This function allows the image layer to be mirrored vertically. This 

enables more precise adjustment of the current image without hav-

ing to make changes to the image layer.  

(9) The Control-Parameter 

Width-to-height ratio: If the width-to-height ratio isn´t fixed with 

the button (6), you will be able to change the width-to-height ratio 

however you desire. 

Zoom: Choose the size of that image level by zooming in or out 

Shifting horizontally: Move the image level to the left or right 

Shifting vertically: Move the image of that level up or down. 

Exposure to light: Exposure levels in your current image may not 

always match those of the image level. Here you can adapt the expo-

sure and darken or brighten the images however you want until they 

match. 
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A night image with a not very fascinating night sky... 

 

....you can change within a minute with the help of composing 

into an eyecatcher. 
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13.  Removal of Scratch and Sensor Errors 

The Scratch and Sensor 

Error Correction function 

is a powerful tool used for 

improving those unsightly 

areas in your photographs. 

Pro Tip: This intelligent correction doesn’t only remove sensor spots, 

but other disturbing things too - a deserted beach has never been so 

easy to produce.   

 

Simply mark defects in your motif, the program will automatically 

substitute these areas with other appropriate parts of the image.  

 

 

 

 

 

 

 

 

 

 

 

The sensor spots are circled in red
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Here’s how to go about correcting: 

Select the brush tool under (6) and click on the point of the image 

that you would like to correct. A circle will appear beside it that will 

serve as a source.   

Move this circle to a place on the 

image that can act as a source 

for the first marking. The select-

ed area will then be improved 

based on the source.  

Prior to this, you can reveal sen-

sor spots, which will appear as a 

bright patch in the image, with 

(1).  

(2) Allows you to expose or hide 

the fixed areas. The corrections 

are still active, even if they have 

been blended in.  Hiding is solely 

to enable a before and after comparison. 

You can select multiple areas to correct by simply clicking on the 

brush symbol (6) and adding another point.   

The button marked (3) can blend the targeted corrections in and out, 

which also controls clarity.  

(5) Deletes the added corrections.   

The section marked (7) controls the size of the area that is to be 

corrected.   

You also have the option to automatically search for the best source 

area for the improvement. Click on the (8) button.  

Button (4) calculates the appropriate correction spots for all of the 

points automatically set using (8). 
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All currently selected corrections can be deleted with the (9) button. 

 

The sensor spot corrector marks all of the patches and determines a 

source within the image that can be used as a substitute. 

 

Successful sensor spot correction. 
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14. Edit Weighting 

 

In the „Edit Weightings“ editing section, you have the ability to alter 

select regions of your photograph. Weight Painter is a tool used to 

manually edit a final image by adjusting individual images in a series.  

Exposure Series View (left): The individual images in a series are 

assigned the colours red, green and blue. When the bracketing has 

more than 3 exposures, the master image will be set as green and 

the next active neighbouring images as red and blue. If you would 

now like to make changes to the weighting of a particular image, pay 

attention to the image’s colour and choose the respective colour in 

the paint symbol bar. Tick on the top left of the image to exclude it 

from or include it in a set being calculated. 

 

Exposure value (EV): The EV slider controls the brightness of an 

exposure bracketed image. 50% correspond to 1 EV.  
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To clarify: The brush does not mean that you paint colours goes 

onto the image, rather that you can adjust the weighting in certain 

areas of individual images. 

Adjusted Weighting: After drawing, you will see the adjusted 

weighting to the right of the individual image. The white drawn 

strokes mean that you have emphasised the selected area of the 

brighter image.  

 

 Important Tools of the Painter: 

Increase weighting  Draw on the selected area to 

enhance the weighting of this 

portion of the image. 

Blurring  If you want soft transitions 

between corrected and original 

areas, trace the blurring func-

tion over the borders to soften 

the transitions. 

Delete weighting Delete the drawn weighting for 

the active image of the series.    

Stamp  The stamping mode not only 

edits the weighting of the cur-

rent image but adjusts the 

weighting of all of the other 

exposures accordingly. For 

example, if you use the paint 

tool to increase the weighting 

of an area in one image, the 

weighting of that same section 

will be reduced in all of the 

other exposures to amplify the 

effect. 
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Reduce weighting  
Draw on the selected area to 

reduce the weighting of this 

portion of the image. 

Delete all  Warning: This function deletes 

all of the drawn weightings and 

returns to the initial settings. 

Brush form  With numerous new brushes, 

you will find the right from for 

your selected area.   

Opacity 

 

Adjust the opacity of the brush. 

Brush size  

 

Adjust the size of the brush. 

HDR-image/ weighting: 

 

This function mixes the view 

be-tween the HDR image and 

the weighting. This is very ef-

fective for maintaining control 

while drawing. 

 

 Motion Fusion Profiles 

Use the Fusion Profiles to save 

parameter settings in motion 

algorithms for future applica-

tion. Here you have the possibility to import or export one or more 

Focus Fusion Profiles. The current algorithm settings can be saved as 

a new profile which can then be given its own unique name. If you 
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would like to delete an active profile from the database, click on the 

trash symbol. 

 

 Parameters: Remove Motion (Multipass) 

The parameters adjust 

the algorithms for the 

loaded image se-

quence.  

The same controls are 

available for all motion 

processes, except for 

the Long-time Expo-

sure, which does not 

have any settings.  

Radius: The radius indicates the distance around a point to be 

inspected for motion.  A small radius should be used for fine 

movements, for example tree-branches. 

Smoothing: Smoothing determines to what degree created 

movement masks are to be blurred before being assembled 

through the final image calculation. The higher the smoothing 

setting, the softer the transitions. 

Motion: The movement or even the movement's intensity indi-

cates how present a movement is in the sequence at hand. Se-

lect a high setting for sequences with lots of movement, for ex-

ample a fair with busy crowds. 

Fluctuation: Use this function to set the difference in brightness 

between moving objects and the background. 

 

Tip: Give different settings a try to find the best values for your 

sequence. 
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 Subject Brilliance 

Activate an intelligent degree of variation in tonal value by click-

ing the check-

box.  

 

 Contrast range 

The contrast range of an image 

is made up of the division be-

tween the brightest area of a 

photo, for example a photo 

taken pointed directly at the 

sun, and the darkest area so in 

the shade areas of the image.  

The brightest area of an image 

has a value of 5 (the value 1 

would mean a white pixel in the image) and the darkest area in 

the HDR image has a value of 0.01. 

If you now divide 5 by 0.01, the resulting contrast rage of 5/0.01 

= 500. This means that the proportion between the brightest to 

the darkest area of the image is 500 to 1.  

Using this contrast range you can take inspiration from the “con-

trast range” area. 

The compression value shows how strong the compression of 

the HDR image brightness is in comparison to a non-

manipulated macro image. Here it is 0%, since we haven’t done 

any changes yet. 

The compression value you can adjust as you wish to. A low val-

ue creates a higher contrast range in the macro image (the mac-

ro is being “stretched” in its brightness). A higher value creates a 
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smaller contrast range (the macro is being “compressed” in its 

brightness). 

Underneath the controller you will find three buttons which con-

trol the automatic optimisation of the contrast range: 

High-contrast: Creates a high-contrast image – one with very 

deep shadows and very bright lights. 

Optimal: Creates a well-balanced image. 

Compressed: Creates an image with a small contrast range. This 

can be helpful with contrast rich bracketing series, since it helps 

to bring out further details in tone mapping. 

As soon as you confirm the automatic modus, you will be able to 

see first-hand how the best values for your current HDR image 

are selected. 

Tip: This value is for every motion algorithm different. So it 

could be a good idea after the change of an algorithm to click on 

the desired automatic. 

Under the automatic optimisation buttons you will find a curve 

display. This shows how much the brightness values of the im-

age have been adapted in the contrast range optimisation of the 

program. 

 

Curve display of the distribution of the brightness value: 

     
High-contrast     Optimal          Compressed 
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In the example above, we can see how the same HDR image 

with the optimisation “high-contrast“ (above image) and the sec-

ond with the optimisation “compressed” (bottom image) are 

handled. 

 

        



NEAT projects 2 professional– User manual 

 

97 

13. Workflow 

 Edit final image further in an external program  

NEAT projects 2 professional offers interaction with external pro-

grams. After successfully completing your initial edits, this lets you 

continue to make further changes in another image editing program 

of your choice.   

 

 Open in other projects programs  

Click on the “Projects” symbol in the toolbar to open the image in a 

different program from the projects series. Use the drop-down 

menu beside the symbol to choose one of the programs that you 

already have installed on your computer. 

 

 

 Open in other photo-editing programs 

To directly open the image in another photo editing program (such 

as Adobe Photoshop), click on the corresponding button in the sym-

bol bar.   

If necessary, go through the settings to 

show the path to the program. Click on 

“Extras” in the menu and select “Set-

tings” in the drop-down menu: 
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Next, click on the “Export” tab. You can enter the name of a photo 

editing program here and save it for later as well.    
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 Work with a Timeline and Restore Points 

This option can be found in the symbol bar at the top of the screen: 

 

“Create Restore Point” saves an in-between point of the current set-

tings. You can now always return to this stage of your editing. You 

can save as many editing restore points as you like. The timeline 

displays the restore points and makes it possible to call up any 

phase with just a single click:   

 

 

This function is especially useful for testing the outcomes of addi-

tional effects and settings on your image. Simply set a restore point 

and carry on editing your picture. If you want to go back, simply click 

on your restore point  in the timeline. Click on  and you can 

add a note as a headline. 
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14. Selecting and Saving Sections of Im-

ages  

Save final images using the buttons in the toolbar, from the file 

menu or use the corresponding keyboard shortcut (Ctrl+S).   

 

 Cropping and captions 

As soon as you have initiated a file save, the cropping and caption 

window will open. If you do not wish to crop or add a caption to your 

image, click on continue.  

 

At the top of your screen you will find several practical aids for per-

fect image composition and cropping.  

You can set the aspect ratio and activate guidelines like the rule of 

thirds, the golden section or the golden spiral.  Practical is also the 

new photo centre display that you can obtain by simply clicking on 

this button. 
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The centre of the window shows your final image. Fix the area to be 

saved by adjusting the corners and borders of the photo.   

At the bottom is an option to enter a 

caption. You can determine the size, 

position and background for the text. 

The size of the text will be automati-

cally coordinated to the final crop-

ping. 

 You can either crop free-hand or 

make use one of the 71 provided 

formats 

 

Please note: If you choose the cropping 

ratio 13 x 18, for example, the final 

image will not be saved as 13 x 18 cm, 

rather as a ratio of 13 to 18.    

 

As soon as the image has been cropped and captioned, confirm the 

save and the following window will prompt you to select a file format 

and name your file.   
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15.  RAW-Processing 

 You can upload and edit RAW image data with the integrated RAW 

mode. Numerous tools are available to you here, such as de-

noising/sharpen, exposure, colour and detail as well as powerful 

distortion capabilities.    

 

Resetting the category: 

Every category can through a click on the reset-button (bottom left) 

be reset to its original state without influencing the settings of the 

other categories. 
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An overview of the most important RAW functions:   

White balance: Here you can regulate the colour temperature. Use 

the pipette to select a white balancing colour directly from the im-

age.    

Denoising/ Sharpness: This feature regulates the image’s noise and 

sharpness. Control the quality and different types of noise such as 

colour noise, banding or hot pixels.   

Colour balance/ white balance: Here it’s all about colour and 

black/white correction. Modify the general colour mood and neutral-

ise white and black - the icing on the cake for professional colour 

correction.    

Exposure: Influence lights, shadows, contrast and brightness in the 

final image. With the new dynamic brightness, you can adapt the 

light to the contents of each image individually.  

Detail: Fine-tune clarity and micro-details with lights, shadows and 

mid-tones.    
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Colour: These colour settings are all about the luminosity of lights 

and shadows. You can even reduce the presence of unwanted 

chromatic aberrations.    

These light diffraction corrections allow you to purposefully remove 

the chromatic aberrations of a certain colour. Thereby a lens curve 

will be calculated backwards on top of the colour channel.  

Palate: Adjust the saturation of individual colours.   

Distortion: Take a closer look. These mighty tools can straighten out 

the horizon, correct camera angles and lens errors. Use “Autofit” to 

automatically trim any awkward borders.    

The reference grid can be adapted in the distance between the grids 

as well as in its transparency. This is how you will always have the 

maximum overview when you are correcting your settings. 
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 Category FX:  

 

This category includes a several 

new special effects like a mist & 

fog correction, save highlights, 

sepia and film grains as well as 

different gradients. 

Pro Tip: 

When you take a landscape shot, 

shift the controller to “Gradient 

top” to a dark tone to create a 

neutral thick (ND) – process filter. 

 

General: Activate the “360° panorama mode” to optimise matching 

edges of images in a panorama series. Save your settings as a cam-

era profile to save time in the future. This can be reset at any time.    
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If you have conducted the settings in RAW mode, click on “apply”. 

If you save your settings in the camera profile, you will save a lot of 

time for future photographs. The settings can be reversed at any 

time.  

 

 

Individual Camera Profiles 

You also have the possibility to create your own individual camera 

profile. To do this, click on  . Individual camera profiles can be 

given their own name and contain all the same functions as profiles 

created automatically. If you would like to delete or rename your 

camera profile, click on the profile from within the dropdown op-

tions list with the right mouse button. 
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Zoom and Brightness 

At the top right you will find the slide controls Zoom and Brightness 

for the Image Display. 

 

Note: With the Brightness of Image Display slide control you are only 

adjusting the brightness of the program display screen and not that 

of the image itself. This allows you to see the effect of a noise reduc-

tion in dark areas, for example. 

 

Histogram 

The Histogram can be found underneath the slide controls.  

RGB: Display of image RGB values at your cursor’s location within the 

image. 

HSL: Display of image HSL values at your cursor’s location within the 

image. 

Note: HSL stands for Hue, Saturation and Lightness. 
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16. Batch Processing 

NEAT projects 2 professional batch processing allows for automatic 

processing of multiple bracketing series. The function can be found 

in the drop-down menu for Extras in the menu bar or by clicking the 

corresponding symbol on the start screen.  

First, choose the source folder where the image sequences are lo-

cated. The files can also be mixed, since the system will automatical-

ly recognise and sort the bracketing series vs single shots. The “In-

clude all subdirectories” checkbox not only searches through all of 

the selected folders, but also all subfolders and their further sub-

folders.   

Note: Remember that looking through folders with several subfold-

ers can require a lot of time. That’s why selecting “C:\“ is not recom-

mended. 

 

Batch Processing: Renaming and sorting 

In the area of the target folder you will be able to activate the “sort 

mode”. You set thereby the batch processing in the renaming and 

sort mode. 
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As soon as the sortation mode is active, new push buttons will ap-

pear. 

File name filter:  

Here you can insert a file name for renaming the image with the help 

of Syntax: 

-Text 

##.# for the number of bracketing series, the number of # signs 

gives the number of places of numbering 

-Text 

##.# for the number of images within the current bracketing series, 

the number of # signs shows the lists the number of places that are 

numbered. 

The file name “Shooting072016_####_##” creates image data in the 

form of: 

Shooting072016_0001_01.cr2, Shooting072016_0001_02.cr2, … , 

Shooting072016_0002_01.cr2,  Shooting072016_0002_01.cr2, … 

Note: To sort your image data into the data carrier without renam-

ing, simply leave the file name empty. 

 

Deleting the original file 

This option you should only use if you are absolutely sure that your 

insertions are correct. 

The original data of the image will then be deleted. Only the newly 

changed sortation and names will remain, the original data of the 

image will then have been deleted. 
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Install a subdirectory per sequence: 

When this function is active, every bracketing series gets its own 

subdirectory. 

 

Note: Remember that looking through folders with several subfold-

ers can require a lot of time. That’s why selecting “C:\“ is not recom-

mended. 

 

 Allocation and automatic bracketing recognition  

This feature takes on all of the work for you. Now you can 

choose between different modes: 
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Automatic allocation: Loads all of the images and based on the 

images’ content, locates those that belong to an exposure bracketing 

series. The brightness as well as the coverage are compared, which 

results in very good automatic recognition.    

Individual images: The “Individual images” option sorts every image 

into its own bracketing series. This setting is very well suited for edit-

ing image sequences, for example, those generated from footage. 

2 image to 9 image groupings: Select this option if you have taken 

HDR films or are certain that the bracketing series in your folder all 

contain the same number of shots. The file names for the final imag-

es will automatically be successive, so that the edited images can be 

directly used in a video editing program.    

Results: Here you can set where the resulting images of the batch 

processing will be saved. Select the corresponding folder with the 

“Target directory (. . .)”  button or enter the name of the folder direct-

ly into the text box.   

Format: You can choose from nine different formats to save your 

resulting images. With .jpg, .tif and .png, there are two 8-bit formats 

(LDR) and four 16-bit formats (HDR). JPG images are always the high-

est quality and TIF files are saved uncompressed and without de-

fects.  

For further web editing, the final images can be saved in Open EXR 

as well as in Portable Floatmap and Radiance RGBE. 
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 Processing Settings        

Select the settings for the image generation here. These apply to 

all of the bracketing series in the batch processing. 

Image Preparation: Allows you to change all RAW processing 

and image orientation settings of the current batch processing.  

Algorithm: Select the movement preset for batch processing. 

Post-Processing: The presets contain all post-processing presets, 

including all of the presets from your “Custom" category that you 

designed yourself. You can also choose a special preset before 

batch processing and apply it to multiple bracketing series.  

Note: Apple computers systematically open this dialog before the 

batch processing window.   

 



NEAT projects 2 professional– User manual 

 

113 

 Image sequence view 

Here you will find information about the located bracketing expo-

sure series. 

 

At the top of the display is the number of listed bracketing se-

ries. Directly below it are three buttons for global activation and 

deactivation of series.   

Activate all exposure bracketing: Activate all corresponding 

bracketing series for the calculation. (Standard setting) 

Deactivate all exposure bracketing: Deactivates all assigned 

exposure bracketing for the calculation.   

Remove single images: Removes all exposure bracketing for 

single images from the calculation and display. You can use this 

option if the program develops a very bright or very dark image 

incorrectly, or if you have taken photos that should not be pro-

cessed by macro. 
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17. Keyboard Shortcuts 

Overview of the integrated Keyboard shortcuts 

An overview of keyboard shortcuts can be found in the main menu 

in the Information section.  

 

Click on this item to open the overwiew: 

 

In the overview you will be able to scroll through the different areas 

where shortcuts are available. 

At the bottom you will find the button “Open in browser”. It saves the 

shortcuts as .html file and opens it in the default browser. 
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General: 

Windows Apple 

Ctrl N  cmd N New Project 

Ctrl O cmd O Load Exposure Bracketing/ Image Sequence 

Ctrl S  cmd S  Save Image 

Ctrl D  cmd D  Print Image 

Ctrl C cmd C Insert Final Image Into Clipboard 

Shift Z  Shift Z  Create Undo-Point 

Ctrl T  cmd T  Open Timeline 

Ctrl F4 cmd F4 Quit Program 

F4 F4 Open RAW Module 

F5 F5 Process Exposure Bracketing/ Image Se-

quence 

F6 F6 Process Weights 

F7 F7 Switch to Post Processing 

Ctrl P  cmd P  Open Setting 

Ctrl B  cmd B  Open Batch Processing 

@  Open Homepage 

Shift F1 Shift F1 Open About Dialogue 

Ctrl E cmd E Display Exif Information 

Ctrl H  cmd H Display/ Hide Histogram 

Ctrl F  cmd F Display Full Image 

 

Image Display Functions: 

Windows Apple 

Ctrl + cmd + Zoom in 

Ctrl - cmd - Zoom out 

Ctrl 0 cmd 0 Adapt to Screen 

Ctrl 1 cmd 1 100% View 

R  R Real-time mode on/off 

L  L Lock Radar Window 
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RAW Development: 

Windows Apple 

Ctrl + cmd + Zoom in 

Ctrl - cmd + Zoom out 

 

History Browser: 

Windows Apple 

Page up  Page up Previous Page 

Page down  Page down Next Page 

Home  Home  To Start 

End End To End 

Cursor left  Cursor left  Previous Entry 

Cursor right  Cursor right  Next Entry 

 

Variation Browser: 

Windows Apple 

Ctrl + cmd + Zoom in 

Ctrl - cmd - Zoom out 

Cursor left Cursor left Move View to the Left 

Cursor right Cursor right Move View to the Right 

Cursor up Cursor up Move View Up 

Cursor down Cursor down Move View Down 

Ctrl 0 cmd 0 Display All 

Space Space Move View around Centre 

S S Select Entry 

Del Del Delete Entry 

X X Compress View 

Home Home Reset View 

Weight Painter: 

1 1 Select Red for Drawing 

2 2 Select Green for Drawing 
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3 3 Select Blue for Drawing 

Ö Ö Increase Brush Size 

# # Reduce Brush Size 

Sensitive Selective Drawing: 

Windows  Apple 

Ctrl +  cmd + Zoom in 

Ctrl -  cmd -  Zoom out 

Ctrl O cmd O 100% View/ Switch Fitting 

A  A Activate Brush 

Shift A  Shift A  Activate Limited Brush 

S S Activate Erasing Brush 

Shift S  Shift S  Activate Limited Erasing Brush 

W W Activate Soft-Focus Brush 

E  E Activate Mark Creation from the Image 

D  D Activate Filling Mode 

F  F Activate Filling Mode for the Brush 

R  R Activate Ray Mode for the Brush 

1 1 Reduce Brush Size 

2 2 Increase Brush Size 

3 3 Reduce Opacity 

4 4 Increase Opacity 

5 5 Softer Contour Recognition 

6 6 Sharper Contour Recognition 

7 7 Reduce Softness 

8 8 Increase Softness 

Ctrl Z  cmd Z Previous Step 

M, Shift M  M, Shift M  Mask Display on/off 

Scratch & Sensor Error Correction: 

Windows Apple 

Ctrl + cmd + Zoom in 

Ctrl - cmd - Zoom out 
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Cursor left, Shift Cursor left, Ctrl Move Active Correction Area to the Left 

Cursor left 

Cursor right, Shift Cursor right,  Move Active Correction Area to the Right 

Ctrl Cursor right 

Cursor up, Shift Cursor up, Ctrl  Move Active Correction Area Up 

Cursor up  

Cursor down, Shift Cursor down,  Move Active Correction Area Down 

Ctrl Cursor down  

Page up Page up Select Previous Correction Area 

Page down Page down Select Next Correction Area 

C  C Activate all Correction Areas 

N  N Set New Correction Area 

Del  Del Delete Active Correction Area 

+ + Increase Active Correction Area 

- - Reduce Aktive Correction Area 

Picture Cropping: 

Cursor left, Shift Cursor left, Ctrl   Move Cropping Area to the Left 

Cursor left 

Cursor right, Shift Cursor right,   Move Cropping Area to the Right 

Ctrl Cursor right  

Cursor up, Shift Cursor up, Ctrl   Move Cropping Area Upwards 

Cursor up  

Cursor down, Shift Cursor down,   Move Cropping Area Downwards 

Ctrl Cursor down    
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18. Integrated list of supported RAW formats 

Located in the main menu under Information is an integrated list of 

supported camera RAW-formats sorted by manufacturer.  

 

Selecting this menu option will open the Camera RAW Formats Win-

dow. 

 

At the top of the window you will find a drop-down selection for filtering the 

list according to camera manufacturer. This way you will find your camera 

faster. 
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To have constant access to the supporting camera RAW- formats via 

a separate window, you can use the function „open in browser“ 

(window bottom left), which will show the list in a standard browser. 

You will also be able to print the supporting RAW-formats from 

there. 
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Hotline/Support 

Contact the FRANZIS Customer Service Team for questions about installation, problems or 

disruptions concerning this software product.  

E-Mail: support@franzis.de  

 

Telephone (Monday - Friday 12-18:00): +49 (0)180 30 02 644  

(0,09 EUR per Minute from German Landines, mobile rates may vary) 

 

Telefax: 0180 300 26 45 (0,09 EUR per Minute from German Landines, mobile rates may 

vary) 

 

Please bear in mind that your inquiries can only be handled by the FRANZIS Customer Service 

Support Team. This is how we can continue to make lasting improvements in our service quality 

while answering your questions quickly and professionally.  

Customer Service quick and easy: 

Have important information concerning your PC system and product ready: 

 Product Name 

 Product-ISBN-Number (These can be found on the back side of the product 

packaging located above the bar code). 

 Operating System of your PC 

 Information about your PC’s Configuration 
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